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PENGANTAR 

 

Era pendidikan yang dipengaruhi oleh revolusi industri 4.0 disebut Pendidikan 4.0. 

Pendidikan 4.0 merupakan pendidikan yang bercirikan pemanfaatan teknologi digital dalam 

proses pembelajaran atau dikenal dengan sistem siber (cyber system). Ahli teori pendidikan 

menggambarkan beragam cara dalam mengintegrasikan teknologi cyber, baik secara fisik 

maupun tidak, ke dalam dunia pembelajaran. Konsep ini juga merupakan lompatan dari 

Pendidikan 3.0 yang lebih mencakup pertemuan ilmu saraf, psikolofi kognitif, dan teknologi 

pendidikan menggunakan teknologi digital dan mobile berbasis web.  

Microsoft office mungkin menjadi istilah yang tidak asing lagi, hampir setiap 

aktivitas dan tugas-tugas kita (Sekolah, Kuliah, mengajar, berdiskusi) mewajibkan kita 

untuk mampu mengoperasikan Microsoft Office. Dalam modul ini kami akan menyajikan 

materi dalam melakukan kegiatan menggunakan Microsoft Office khususnya (Microsoft 

Word, excel dan PowerPoint).   

Mudah-mudahan dengan penyajian modul ini memberikan manfaat dalam 

segala bentuk kegiatan belajar mengajar, sehingga dapat memperlancar dan 

mempermudah proses pencapaian tujuan pendidikan yang telah ditetapkan. 

 

 

 

Penyusun 

 

Tim ICT SMAN 1 Tuban 
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BAB I  : PENGGUNAAN PERANGKAT LUNAK PENGOLAH KATA 

 

A. Kompetensi 

Setelah membaca modul ini siswa diharapkan mampu:  
1. Melakukan teknik Daftar isi Otomatis 
2. Melakukan teknik Bullet and Numbering  
3. Melakukan teknik Format Painter 
4. Melakukan teknik Find and Replace 
5. Melakukan teknik Menambahkan Kamus Bahasa Indonesia 
6. Melakukan teknik Format Halaman  
7. Melakukan teknik Proteksi File dan Dokumen 

 

B. Uraian Materi  

1. Teknik Daftar isi Otomatis 

Buka atau ketiklah sebuah artikel dahulu yang akan ditambahkan daftar isi. 
bagaimana cara membuat daftar isi dengan titik-titik setelahnya ini semua office itu 
mirip entah itu office 2007, office 2010, 2013, ataupun 2016 semua menggunakan 
metode yang sama yaitu menggunakan Heading dan Table of Contents. 
1) Pilih setiap kalimat yang akan dijadikan daftar isi. Menu home lalu pilih pada bagian 

Styles → Heading dengan pilihan  heading 1. 

 
2) Pilih kalimat lain di bawah heading 1 yaitu sebagai Heading 2, pada kalimat dimana 

saja kalimat yang diinginkan. 
3) Berikutnya jika memang ada bagian artikel yang masih bisa di jadikan heading 3 bisa 

memberikan lagi heading 3 yang letaknya biasanya sesudah heading 2. 
4) Lakukan cara seperti nomor 1 sampai pada nomor 3 ke semua bagian artikel, di 

sinilah point terpenting dari pembuatan daftar isi yaitu menjadikan kalimat yang 
akan dijadikan sebagai Heading 1, Heading 2, heading 3, heading 4 dan seterusnya.  

5) Membuat daftar ini pada halaman yang diinginkan bisa di awal makalah atau di 
akhir makalah. Daftar isi yang akan dibuat berada di halaman ke-3 makalah maka 
saya klik pada halaman ke-3. 

6) Pilih menu REFERENCES kemudian klik pada bagian TABLE OF CONTENT.  table of 
content ini berfungsi mengumpulkan semua heading yang telah di setting 
sebelumnya.  

7) Pilih tampilan daftar isinya, setelah muncul kotak pilihan table of contents, disini 
saya memilih OUTOMATIC TABLE 1.  

 
8) Secara otomatis semua heading yang telah dibuat tadi akan tersusun menjadi 

sebuah daftar isi berdasarkan urutan yang sudah dibuat.  
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2. Teknik Bullet and Numbering 

Bullet and Numbering merupakan fasilitas yang telah disediakan oleh Microsoft 
Office. Bullet sendiri memiliki arti simbol atau bentuk yang unik yang biasanya 
digunakan untuk menandai atau hanya untuk mempercantik tampilan. Sedangkan 
Numbering adalah penomoran otomatis pada sebuah teks atau bahkan paragraf. 
Numbering dapat berupa angka, angka romawi, dan dapat juga berupa huruf. Ada juga 
yang berupa icon-icon kecil unik. 

Bullet and numbering biasanya digunakan pada sebuah susunan menu, daftar 
atau kata-kata yang sifatnya tersusun. 
Cara Membuat Bullet and Numbering 
1) Pada lembar kerja Ms. Office Word 
2) Blog kata yang ingin diberi Bullet atau Number 
3) Klik menu Home pada Menu Bar 
4) Pilih Bullet atau Number pada group Paragraph 

 
5) Maka akan secara otomatis tampil Bullet atau Number yang diinginkan. 
Untuk menambahkan bullets pada beberapa paragraf sekaligus, langkahnya adalah: 
1) Blok paragraf yang hendak diberi bullet and numbering. 
2) Tekan Ctrl+Shift+L. 
Menghentikan bullets and numbering: 
1) Blok Kalimat 
2) Tekan Ctrl+Shift+N untuk menghilangkan style dan kembali ke paragraf normal. 
Maju atau mundur satu level pada bullet atau numbering: 
1) Blok Kalimat 
2) Tekan Tab atau Shift+Tab. 
Membuat paragraf tanpa membuat bullet atau numbering baru: 
1) Letakkan kursor di akhir kalimat. 
2) Tekan Shift+Enter. (Tekan enter untuk melanjutkan bullet atau numbering 

berikutnya) 
 

3. Teknik Format Painter 

Cara Menggunakan Format Painter sebagai berikut: 
1) Klik pada objek yang akan disalin formatnya. 

Catatan: Jika Anda ingin menyalin format teks dan paragraf, pilih seluruh paragraf. 
2) Kemudian pilih salah satu dari langkah berikut: 

a. Untuk menempatkan format pada satu objek: pada tab Home, grup Clipboard, 
klik Format Painter. 
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b. Untuk menempatkan format pada lebih dari satu objek: pada tab Home, 

grup Clipboard, klik ganda Format Painter. 
Tip: 
➢ Kita juga bisa menggunakan tombol keyboard untuk menyalin format (CTRL+ 

SHIFT + C) dan menempatkannya (CTRL+ SHIFT + V) pada lebih dari satu 
objek. 

➢ Cara 2). b berguna untuk menempatkan format pada objek di halaman yang 
berbeda yang tidak berurutan. 

3) Pointer akan berubah menjadi icon kuas. Selanjutnya klik objek yang ingin diberi 
format.  
Catatan: bila posisi paragraf letaknya berurutan, klik dan geser mouse untuk 
menempatkan format. 

4) Untuk menonaktifkan Format Painter, tekan tombol ESC atau tekan tombol Format 
Painter pada tab Home, grup Clipboard. 

4. Teknik Find and Replace 

Fitur Find dan Replace di Microsoft Word sangat membantu dalam menemukan 
teks atau karakter tertentu, dan menggantinya dengan teks lainnya, memberi format 
baru, maupun untuk menghapusnya. 
1) Menemukan dan Menandai Teks pada Dokumen 

a. Tekan tombol CTRL + F untuk membuka tab Find, Tekan tombol CTRL + H untuk 
membuka kotak dialog Find and Replace dan kemudian klik tab Find. 

b. Ketik teks yang ingin ditemukan di kotak Find → Find what. 
c. Kemudian klik tombol Reading Highlight, dan pilih Highlight All. 

Microsoft Word akan memberi tahu jumlah pencarian yang ditemukan dan di-
highlight. 

 
Hasilnya seperti gambar berikut ini. Semua teks yang ditemukan akan di-
highlight.  

d. Untuk menghilangkan highlight, klik lagi tombol Reading Highlight, dan 
kemudian klik Clear Highlighting. 

2) Menggunakan Kode untuk Menemukan Teks, Angka, atau Karakter Tertentu 
Kita dapat menggunakan kode pada kotak Find what untuk mencari teks, 

angka, atau karakter tertentu. Misalnya, ketik ^#^#^# untuk menemukan angka 
dengan 3 digit. Atau ketik s^$t untuk mencari teks yang terdiri dari 3 huruf, diawali 
dengan huruf s dan diakhiri dengan huruf t. 
Caranya: 
a. Tekan tombol CTRL + F untuk membuka tab Find, Tekan tombol CTRL + H untuk 

membuka kotak dialog Find and Replace dan kemudian klik tab Find. 
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b. Ketik kode di kotak Find what. Pada contoh di sini: ^#^#^# yang akan memberi 
hasil seperti berikut: 

 
3) Menemukan dan Mengganti Teks pada Dokumen 

Trik ini berguna untuk mengganti teks secara cepat tanpa harus 
mengetiknya satu persatu. Pada contoh ini, kita akan mengganti tulisan ‘web’ 
dengan ‘website’. 
Caranya: 
a. Tekan tombol CTRL + H untuk membuka tab Replace pada kotak dialog Find and 

Replace. 
b. Ketik teks yang ingin diganti di kotak Find what: 

 
Tambahkan juga pengaturan berikut untuk menemukan teks yang lebih spesifik: 
➢ Tekan tombol More >> untuk menampilkan Search Options. 
➢ Centang kotak Find whole words only, untuk menemukan teks persis seperti 

yang di ketikkan pada kotak Find what tanpa membedakan huruf besar atau 
huruf kecil. 

➢ Centang kotak Match case juga, bila ingin membedakan teks yang huruf 
besar dengan huruf kecil.  

c. Di kotak Replace with, ketik teks penggantinya. 
d. Selanjutnya, lakukan salah satu dari hal berikut ini: 

➢ Klik Find Next, untuk berpindah ke teks berikutnya yang ditemukan. 
➢ Klik Replace, untuk mengganti teks yang ditemukan.  

Cara ini berguna untuk mengganti teks satu persatu dan jumlah teks yang 
ingin diganti tidak banyak. 

➢ Klik Replace All, untuk mengganti semua teks yang ditemukan tersebut. 
Cara ini berguna untuk mengganti teks dalam jumlah banyak. 
Kekurangannya, bila pengaturannya tidak tepat, maka hasilnya bisa 
berantakan.  
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e. Seandainya terjadi kesalahan dalam mengganti teks, tekan CTRL + Z, untuk 
membatalkan perintah Replace atau Replace All. 

5. Teknik Format Halaman 

Untuk membuat sebuah dokumen dengan halaman yang berbeda-beda, 
biasanya anda membagi dokumen tersebut menjadi dua atau tiga file yang terdiri dari 
file yang berisi halaman sampul dan satunya lagi file dengan halaman dengan nomor 
angka romawi, selanjutnya file dengan penomoran angka standar. Namun hal seperti itu 
dapat kita jadikan menjadi satu file saja yang terdiri dari halaman dengan nomor romawi 
dan halaman dengan nomor angka standar. Untuk itu anda harus membuat section 
break. Dan berikut ini adalah cara yang bisa anda lakukan: 
1) Untuk membuat sebuah halaman yang memiliki nomor romawi, misalnya saja 

halaman judul sampai kata pengantar, klik Menu insert → Header & Footer → Page 
Number → Bottom of page → Plain number 2. 

 
➢ Maka halaman 1 akan terlihat pada halaman judul. Untuk merubah angka 

standar menjadi angka romawi, klik pada page number dan pilih Format page 
numbers. 

➢ Pada number format pilih i, ii, iii,…. Dan klik OK, maka nomor halaman akan 
berubah dari angka 1 menjadi i (angka romawi 1) 

➢ Sampai di sini semua halaman menggunakan angka romawi kecil. 
2) Untuk membuat halaman menjadi angka standar dan dimulai dari angka 1 tanpa 

merubah format nomor halaman sebelumnya, maka harus dibuat section break. 
Caranya adalah letakkan kursor pada halaman BAB I atau halaman yang nomor 
halamannya akan dirubah. Kemudian klik Layout → Breaks → Next page. Sampai di 
sini new section break telah terbentuk. 
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➢ Klik ganda pada Footer/nomor halaman, pada ribbon design, group menu 

navigation, lalu non aktifkan tombol Link to previous. Klik tombol tersebut 
hingga tidak berwarna kuning lagi. 

➢ Hapus nomor halaman tersebut, kemudian pada ribbon design, group menu 
Header & Footer klik page number. Dan pilih format page numbers. 

➢  Pada number format ubah i, ii, iii,…. Menjadi 1,2,3,… kemudian pada pilihan 
start at pilih 1 dan klik OK. 
 

6. Teknik Menambahkan Kamus Bahasa Indonesia 

Kesalahan dalam pengetikan pada sebuah kata di Microsoft Word adalah hal 
yang lazim dilakukan, baik yang masih awam ataupun yang telah mahir sekali pun dalam 
hal ketik mengetik kadang kala tak luput dalam melakukan kesalahan pengetikan. 
berikut Cara Mudah Koreksi Salah Ketik Di Microsoft Word: 
1) Secara default Microsoft Word sudah dilengkapi dengan fitur pendeteksi kata yang 

salah ketik yang secara otomatis menandai kata yang salah ketik (atau tidak ada 
dalam kamus) dengan garis bawah berwarna merah. Namun fitur tersebut 
berformat Bahasa Inggris, jadi kata yang dideteksi oleh fitur tersebut hanyalah 
kosakata yang berbahasa Inggris saja. Nah karena yang anda ketik dalam format 
Bahasa Indonesia, maka yang harus anda lakukan pertama kali adalah mengunduh 
dan menginstal file plugin Kamus Bahasa Indonesia untuk fitur pendeteksi otomatis 
Microsoft Word, silahkan anda unduh melalui link dibawah ini:  

Plugin Kamus Bahasa Indonesia untuk Microsoft Word.zip (242 KB).  

2) Setelah mengunduh Plugin Kamus Bahasa Indonesia untuk Microsoft Word, karena 
format file nya dalam bentuk .zip, maka silahkan anda ekstrak terlebih dahulu dan 
letakkan file hasil ekstrak tersebut (Kamus Bahasa Indonesia.dic) di folder atau 
directory yang mudah anda akses.  

3) Jalankan aplikasi Microsoft Word anda, kemudian klik Menu File dan pilih Options.  
4) Setelah jendela Word Options terbuka, silahkan anda klik tab Proofing. Pastikan ada 

tanda centang pada opsi Check spelling as you type, Mark grammar errors as you 
type, frequently confused words, dan Check grammar with spelling. Selanjutnya 
klik Custom Dictionaries.  

http://adf.ly/1M0s2R
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5) Buka dokumen yang ingin anda koreksi pada Microsoft Word dan kemudian blok 

seluruh tulisan yang terdapat pada dokumen tersebut (Ctrl + A).  
6) Klik tab Review pada Menu Bar dan pada opsi Language, pilih Set Proofing 

Language.  
7) Setelah jendela untuk pengaturan Language terbuka, silahkan anda pilih atau 

klik ENGLISH (U.S.) dan pastikan tidak ada tanda centang pada opsi Do not check 
spelling or grammar dan pastikan pula ada tanda centang pada opsi Detect 
language automatically. Selanjutnya klik OK.  

 
8) Setelah itu, maka secara otomatis terdapat garis bawah berwarna merah pada kata 

yang salah ketik di dokumen anda.  
Untuk memperbaikinya cukup mudah, klik kanan pada kata yang bergaris bawah 
berwarna merah, maka akan muncul beberapa pilihan kata yang direkomendasikan.  
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7. Teknik Proteksi File dan Dokumen 

Berikut ini adalah langkah untuk mengunci teks supaya tidak bisa dirubah kecuali 
mengetahui password nya sebagai berikut: 
1) Klik tab Review → Protect Document / Restrict Editing . 
2) Lalu akan menampilkan task pane di sebelah kanan, Beri centang pada pilihan 

“Allow Only This Type of Editing in The Document”, lalu pilih “Filling in Forms”. 
3) Untuk memproteksi/memberi password, klik “Yes, Start Enforcing Protection”, dan 

masukkan password nya. 

 
   

4) Sedikit Penjelasan pada 4 pilihan “Allow Only This Type Of Editing In The 
Document”, yaitu: 
a. Tracked Change: kita masih bisa mengedit document tersebut. 
b. Comment: saat kata diganti akan muncul komentar, kata apa saja yang dihapus. 
c. Filling in Form: hanya bisa dibaca saja, tidak bisa diedit, dan tidak bisa di copy. 
d. No Change (Read Only): hanya bisa dibaca, tidak bisa di edit, tetapi bisa di copy. 

Untuk membatalkan proteksinya lihat langkah-langkah dibawah: 
a. klik “Stop Protection” Lalu masukkan password yang sobat buat tadi. 

 
 

C. Lembar Kerja Praktik 1 

1. Buka file Makalah atau File bacaan yang anda punyai. 
2. Perbaiki formatting teks yang sesuai dengan aturan yang benar sesuai dengan 

permasalahan yang anda buka dengan menggunakan Teknik Bullet and Numbering, 
Format Painter, Find and Replace, Koreksi kata dengan Menambahkan Kamus Bahasa 
Indonesia, Daftar isi dan Halaman Otomatis, dan Proteksi File dan Dokumen. 

 
** Selamat Mencoba! Semoga Sukses! ** 
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BAB II  : PENGGUNAAN PERANGKAT LUNAK PENGOLAH PRESENTASI 

 
A. Kompetensi 

Setelah membaca modul ini siswa diharapkan mampu:  
1. Melakukan teknik Dasar Slide Master  
2. Melakukan teknik Dasar Animation, Triggers, dan Link  
3. Melakukan teknik Package Presentasi 

 
B. Uraian Materi  

1. Teknik Slide Master 

Slide master adalah fitur dalam PowerPoint yang memungkinkan Anda 
membuat template presentasi PowerPoint dan mengedit sendiri template PowerPoint 
tersebut sesuai selera Anda. Dengan memanfaatkan slide master Anda akan mampu 
membuat slide yang menarik dan konsisten dalam waktu yang lebih singkat. Berikut 
adalah langkah-langkah untuk mendesain template atau membuat slide master pada 
Microsoft PowerPoint Semoga bermanfaat. 
1) Buka Lembar kerja baru, kemudian tambahkan page slide, dengan cara tekan enter 

atau pilih new slide, maka beberapa pilihan bentuk layout akan muncul. Dalam 
pilihan layout tersebut belum ada content yang tiga kolom. Hanya tersedia dua 
kolom yaitu dengan nama Two Content, seperti yang terlihat pada gambar di 
bawah ini. 

 
2) Langkah berikutnya yaitu aktifkan menu View dan pilih Master slide pada ribbon 

Presentation Views. 

 
3)  Desain ukuran dan letak dari tersebut sesuai yang Anda kehendaki. Lihatlah. 

gambar/logo sudah masuk di semua slide. 
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4) Ingat Slide paling atas dipastikan sudah terseleksi. Jika yang terseleksi bukan pada 

layout yang paling atas, maka gambar/logo tersebut hanya terinsert pada layout 
yang sedang terseleksi atau sedang aktif. 

5) Simpan template melalui menu Slide Master → Themes → Save Current Theme 
→ Berikan Nama File → Save. 

 
6) Setelah diubah klik kanan pada thumbnail slide layout (slide kecil di sebelah kiri) 

yang telah menjadi tiga kolom, pilih rename layout untuk mengganti nama dari 
layout tersebut. Setelah itu klik tombol close. 

 
2. Teknik Dasar Animation, Triggers, dan Link 

Untuk membuat presentasi yang interaktif maka kita perlu memahami konsep 
Animasi, triggers, dan Link. Adapun langkah-langkahnya sebagai berikut: 
1) Animation 

a. Pilih Object yang akan di berikan animasi 
b. Klik Menu Animations → Animation Pane → Add Animations (Pilih Salah satu) 
c. Lihatlah di Animation Pane akan memperlihatkan jenis animasi yang telah di 

Tambahkan. 
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2) Triggers 
a. Perhatikan Animation Pane → Pilih salah satu animasi → Klik Panah ke bawah 

→Pilih Timing. 
b. Pada Peek In → Pilih Triggers → Start effect on click of (Pilih Target 

pengontrolnya misalnya : group 8) → Ok  

 
c. Perhatikan di Animation Pane akan berubah 

 
3) Link 

a. Pilihlah Target objek yang akan diberikan Link 
b. Pilih Menu Insert → Pilih Action → Pada kotak dialog Action Setting Pilih 

Hyperlink to → Pilih Slide → Pada Kotak dialog Hyperlink to slide pilih Slide 
yang di targetkan → Ok. 

 
 

3. Teknik Package Presentasi 

Agar desain dan link file tidak berubah jika berpindah komputer, maka 
alangkah baiknya jika file Microsoft PowerPoint di Pack, adapun langkahnya sebagai 
berikut: 
1) Klik Menu File → Pilih Export → Package Presentation for CD → Package for CD. 
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2) Klick Copy to Folder 

 
3) Pilih Browse cari dimana file nanti akan di simpan 

 
4) Pilih Yes 

 
 

C. Lembar Kerja Praktik 2 

Bukalah Microsoft PowerPoint kemudian buatkan Materi Presentasi (materi bebas) 
dengan Slide Master, Animation, Triggers, dan link di Microsoft PowerPoint. 

 
** Selamat Mencoba! Semoga Sukses ** 
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BAB III : PENGGUNAAN PERANGKAT LUNAK PENGOLAH ANGKA 

 
A. Kompetensi 

Setelah membaca modul ini siswa diharapkan mampu:  
1. Melakukan teknik Short and Filter 
2. Melakukan teknik Rumus-rumus 
3. Melakukan teknik Link Sheet and document 

B. Uraian Materi  
1. Teknik Short and Filter 

Sort merupakan salah satu tools yang terdapat pada aplikasi Microsoft Excel yang 
digunakan untuk mengurutkan data berdasarkan ketentuan yang diberikan. Adapun 
langkah untuk menggunakan filter adalah sebagai berikut: 
1) Blok data yang akan di urutkan 
2) Pilih menu home → Sort & Filter → Custom sort → Tentukan Kriteria pengurutan 

data sesuai dengan yang dikehendaki. 

 
Filter dalam Microsoft Excel berguna untuk menyaring data yang banyak agar 

mudah dalam mencari atau mengategorikan atau juga mengelompokkan data 
berdasarkan apa yang kita inginkan. Adapun langkah untuk menggunakan filter adalah 
sebagai berikut: 
1)  Letakkan pointer pada cell title kolom yang dikehendaki 
2)  Pilih menu Data → pilih Filter → Pilih nama kolom yang dikehendaki untuk di saring 

→ Tentukan penyaringannya → Ok 
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2. Rumus-rumus Logika dan Vlookup 
1) Logika Sederhana 

 
2) Logika Majemuk 

 
3) Logika Boolean 
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4) Fungsi Vlookup 

 
 

3. Teknik Link Sheet  
Untuk memudahkan pemanggilan workbook yang ingin kita buka, kita bisa 

memanfaatkan salah satu fungsi atau rumus di Microsoft Excel yaitu Fungsi HYPERLINK. 
Adapun langkah untuk membuat link sebagai berikut: 
1) Buatkan desain di Microsoft Excel baik itu menggaunakan gambar atau shape 
2) Klik kanan pada Menu yang diinginkan → Hyperlink / Link 

 
3)  Pilih Place in this Document jika akan di linkkan pada sheet yang ada di dalam file 

itu → Pilih Sheet yang diinginkan → Ok 
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C. Lembar Kerja Praktik 3 
 

Selesaikanlah permasalahan berikut dengan tepat! 
 

 
 

** Selamat Mencoba! Semoga Sukses ** 
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BAB IV : EMBEDING AND OBJECT LINKING 

 
A. Kompetensi 

Setelah membaca modul ini siswa diharapkan mampu:  
1. Melakukan teknik Embeding 
2. Melakukan teknik Object Linking 

3. Mentransfer Objek Secara Linking Dengan Tool Insert Objek 

B. Uraian Materi  
1. Teknik Embeding 

Embedding adalah ketika melakukan transfer objek dengan cara embedding, 
objek atau yang ditransfer ke program aplikasi yang tidak mempunyai hubungan (link) 
dengan program aplikasi sumber. Kita mengedit objek yang ditransfer pada program 
aplikasi tujuan. 
Langkah-langkah mentransfer objek secara embedding: 
1) Pilih salah satu file yang akan ditransfer. Misalnya, contoh dokumen pada Ms. Excel 
2) Buka dokumen tersebut, kemudian data yang akan ditransfer di blok 

 
3) Buka lembar kerja baru di Ms. Word, klik File lalu klik tanda panah ke bawah pada 

icon Paste lalu pilih Paste Special. 

 
4) Pada kotak dialog Paste Special pilih Paste, dan pada kotak pilihan objek pilih 

Microsoft Excel Worksheet Object. 
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5) Kemudian klik tanda Ok pada kotak dialog tersebut. 
6) Hasil setelah ditransfer. 

  
 

Catatan: 
Jika ada data yang tidak sesuai dengan keinginan kita maka data tersebut dapat 
diedit pada lembar kerja Ms. Word. Tetapi lembar kerja pada Ms. Excel tidak akan 
berubah. 

2. Teknik Object Linking 
Linking adalah ketika melakukan transfer objek dengan cara linking, objek atau 

yang ditransfer ke program aplikasi yang masih mempunyai hubungan (link) dengan 
program aplikasi sumber. Ketika kita melakukan pengeditan objek pada program aplikasi 
program, objek yang ditransfer pada aplikasi program tujuan ikut berubah juga. 
Langah-langkah untuk mentransfer objek secara linking: 
1) Lakukan persiapan yang sama dengan yang diatas 
2) Buka dokumen tersebut, kemudian data yang akan ditransfer di blok 

 
3) Buka lembar kerja baru di Ms. Word, klik File lalu klik tanda panah ke bawah pada 

icon Paste lalu pilih Paste Special. 
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4) Pada kotak dialog Paste Special pilih Paste Link, dan pada kotak pilihan objek pilih 
Microsoft Excel Worksheet Object. 

 
5) Kemudian klik tanda Ok pada kotak dialog tersebut. 
6) Jika kita mengedit lembar kerja pada Ms. Excel maka secara otomatis lembar kerja 

yang ada pada Ms. Word akan ikut berubah juga 
 

3. Mentransfer Objek Secara Linking Dengan Tool Insert Objek 
Langkah-langkah sebagai berikut: 
1) Lakukan langkah-langkah persiapan seperti diatas 
2) Klik insert lalu pilih objek 

 
3) Klik tab Create from File, gunakan Browser pada kotak dialog untuk memilih data 

yang akan digunakan dimana objek Excel yang akan ditransfer berada. 
4) Setelah memilih objek klik kotak cek pilihan Link to file untuk memberi tanda 

cheklist. 

 
5) Kemudian klik ok. 

C. Lembar Kerja Praktik 4 
Buatlah dokumen yang mengunakan Embeding and Object Linking baik itu dari: 
1) Microsoft PowerPoint ke Microsoft Word  
2) Microsoft Word ke Microsoft PowerPoint 
3) Microsoft PowerPoint ke Microsoft Excel 
4) Microsoft Excel ke Microsoft PowerPoint  
5) Microsoft Word ke Microsoft Excel 
6) Microsoft Excel ke Microsoft Word  

** Selamat Mencoba! Semoga Sukses ** 
 


